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Abstract: The design of a novel electrothermal microgripper device is shown, which is based
on an improved chevron type actuator developed considering their elements parameterization,
whose resistive model is also provided. The performance of the microgripper’s parameters, such as
displacement, force, and temperature distribution, with convection for the voltage range from 0 up
to 5 V, is evaluated through numerical and analytical simulation. Microgripper design was also
improved with aid of parameterization. The effect on the microgripper performance due to its
thickness is also analyzed, finding a considerable increment in force, when thickness increases.
Its main advantage is given by the simplicity of the compliance arrangement of the microgrippers
jaws. Considering convection, when 5 V are applied, 37.72 ◦C was generated at the jaw’s tips of
the Improved Microgripper 2 (IMG2), implemented with silicon, this relatively low temperature
increases its capabilities of application. When the IMG2 is implemented with polysilicon, its response
is competitive comparing with a more complex microgripper, increase of displacement (50%) is
shown, but a decrement of force (30%). The diameters allowed for the subjection objects are found
between 84.64 µm and 108 µm, with weights lower than 612.2 µg. Some tests of subjection were
performed using microcylinders of Au, glass ceramic, polycarbonate and carbon fiber, showing
a permissible stress on them, considering its Young’s modulus, as well as the total reaction force
induced. All simulations were done on Ansys software. The results demonstrate the feasibility of the
future microgripper fabrication.

Keywords: parameterization; compliance arrangement; displacement; temperature distribution;
force; silicon; polysilicon; microparticles subjection; Ansys

1. Introduction

Microelectromechanical systems (MEMS) involve both electronic and non-electronic elements,
and perform functions that can include signal acquisition, signal processing, actuation, display and
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control [1]. MEMS refer to a set of microsensors and microactuators that can perceive environments
and have the ability of reacting to changes in those environments, using the control microcircuits [2].

Microactuators based on different actuation principles, such as shape memory alloys, electrostatic,
electrothermal, piezoelectric, pneumatic, and electromagnetic approaches, have been devised to drive
MEMS microgrippers. Electrothermal actuation is widely applied in MEMS. Typically, it can generate
a large output force by using low voltages [3].

The electrothermal actuation consists of the thermal expansion of the clamping arms, due to the
Joule effect, in the presence of electric current. Electrothermal micro clamps have many advantages,
such as wide deformation, strong clamping force, low operating voltage, and compact structure.
However, the limitations of electrothermal actuators are related to the high temperature in the region
close to the clamping targets, so long clamping arms must be used to dissipate the heat produced by
the actuators [4], among other strategies that have been used. Microgripper performance depends on
the actuation method, material properties, geometry, and kinematic behavior [5]. In this case, the work
focuses on the geometry improvement, which provide an increment on jaw’s displacement and in their
reaction force. These parameters determine the size and weight of the subjection objects.

Compliant mechanisms can be used to design mechanisms having specific force-deflection
properties, e.g., compliant constant-force mechanism, which generates a nearly constant output
force in response to, say, a linear input displacement [6]. They are widely used in several areas,
such as robotics and precise positioning systems. Such mechanisms can be used as motion or force
amplifiers/reducers [7]. Among their well-known advantages, are no friction, light weight, no need for
lubrication, and zero backlash. They can contain fewer parts or can be manufactured as one piece [8].
They are flexible structures that deliver the desired motion and force by undergoing elastic deformation
as opposed to rigid-body mechanisms [9].

In microelectromechanical systems (MEMS), compliant devices offer an alternative to obtain
micromechanical movements without requiring mechanical assembly. The majority of microdevices
and systems rely on mechanical compliance (flexible structures) to take advantage of micromachining
techniques and to meet batch production constraints [10]. They have been widely used also for
microgripper design [11].

Microgrippers Actuated by Chevrons

Several examples of micro-grippers actuated by chevron actuators can be found in the literature
(some of them are given in Table 1). In this work, the electrothermal microgripper will also be actuated
by a chevron actuator.

More examples of microgrippers actuated by chevron are given in [11], and some patents in [12].
Silicon has been widely used for fabrication of MEMS devices, especially due to its mechanical

properties, its low cost, the maturity of its knowledge, as well as its compatibility with fabrication
processes of integrated circuits. Electrostatically [13–15] and mechanically [16] actuated MEMS silicon
microgrippers are also reported.

From the analyzed literature, a challenge arises in relation to the improvement of the microgripper
elements, not only of the chevron actuator, but also of the compliance arrangement, which is the base
of each arm. This interest in due to, currently, it is possible to develop parametric analyzes reducing
both the time and costs involved in the design process. The simulation software, in the parametric
analysis, automatically solves complete ranges of specific variables. The graphical display of their
results allows the user to detect trends, by analyzing the performance shown, and choose the most
appropriate values of the variables, according to the established requirements, based on the needs of
the application to which they will be destined.

Parametric design significantly reduces the time and cost of developing design processes,
while guiding the development of a robust design. In complex system design processes, it is common
to follow proven design methodologies, such as Model V or Smart product system design model,
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where the intermediate stage, which is called Detailed Design and Optimization [17], is directly related
to parametric analysis.

Table 1. State of the art of advances in microgrippers actuated by chevron actuators.

Description Displacement
(µm)

Force
(µN)

Dimensions
(µm) Material Feeding Ref.

Electrothermal
microgripper with
chevron microactuator

1.39 N/A ~102 × 35 × 1 Nickel 28 mA [18]

Microgripper with
chevron microactuator 80 ~200 2900 × 3500 × 45 SU-8 53 mV [8]

Electrothermal
microgripper 310.6 N/A ~13,500 × 2500 × 180 Silver/Nickel 0.26 A [19]

Microgripper with
chevron
electrothermally
actuated

19.2 37000 ~870 × 200 × 10 Polysilicon 0–1.2 V [20]

Electrothermal
microgripper with two
chevrons

40 N/A ~1300 × 530 × 4 Ni 1 V [5]

Microgripper Based on
the Cascaded
V-ShapedActuators

>50 N/A ~1000 × 1500 × 20
SU-8 (with
Cr/Au/Cr

films)
26–28 mA [21]

Microgripper based on
chevron actuator 71.5 N/A ~3500 × 3120 × 45 Copper-SU-

8-Copper 195 mV [22]

In this paper, determinant elements of chevron actuator have been parameterized, such as its
inclination angle, and the width of its shuttle, considering their effects on the displacement and
the reaction force on the shuttle, for each case. In addition, the parameterization of the complete
microgripper will be carried out considering the effect of the change in the values of the angles of the
compliance arrangements that are decisive in the operation, as well as the length of the arms effect.

Our aim is the design of a novel and simple microgripper based on a chevron actuator, and a
compliance arrangement. The content of this work is organized as follows. In Section 2, design of
the elements of the microgripper are provided, as well as the conventional mathematical model of
chevron actuator and the basis of the microgripper. Simulation results of the main parameters of the
microgripper, a comparison with another microgripper, and some objects holding tests, are provided
in Section 3. Finally, in Section 4, some concluding remarks are given.

2. Materials and Methods

Silicon is used as structural material for the microgripper design, its parameters are shown in
Table 2. Polysilicon was also chosen for generalizing the obtained results and compare the performance
of microgrippers, its parameters are also given in Table 2.

Table 2. Physical and mechanical properties of silicon [23–25] and polysilicon [26].

Parameters Values for Silicon Values for Polysilicon

Density, [kg/m3] 2329 2320
Thermal expansion coefficient, α [1/◦C] 2.568e−6 2.6e−6

Young’s Modulus, E [Pa] 1.301e11 1.60e11
Poisson’s ratio, υ 0.33 0.22

Bulk Modulus [Pa] 1.27e11 9.4e10
Shear Modulus [Pa] 4.89e10 6.475e10

Thermal conductivity, [W/(m/◦C)] 148 34
Resistivity, % [Ω*m] 1.5e−4 2.2e−5
Melting point [◦C] 1414 1411.85
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The schematic diagram of the proposed electrothermic chevron, which actuates the microgripper
is depicted in Figure 1. Its performance will be analyzed, with the aid of an improvement process
based on parametric analysis, described in the flux diagram shown in Figure 2, to take decisions
about any change on the geometry. In this established process, at first, the performance parameters to
improve, must be determined, as they will guide to the user’s decisions. The knowledge of the possible
device applications will be very useful in this determination. As second step, it is necessary to identify
the determinant geometric elements on the initial device performance, because, individually, all of
them will be parameterized. The graphical deployment of their results (step 3) will be useful to user,
for the determination of the most suitable dimensions of the determinant elements of the geometry
(step 4). Some design rules of the fabrication process, previous knowledge and expertise should be also
considered in the decision making. The enhanced geometry will be determined with this selection of
elements dimensions (step 5). Later, it is necessary to simulate the improved device in order to analyze
its performance parameters (step 6). If the appropriated parameter values have been obtained (step 7),
the process will be finished, or it will be necessary to go back to step 4 and continue again since this
point, until the chosen performance parameters would have suitable values.
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As it can be observed, automated sweeps, quickly performed, generating useful information
to analyze performance trends and, therefore, to select the most appropriate values of the variables
under analysis, in accordance with the established requirements and conditions. Parameterization was
performed without consider convection. Dimensions of the proposed chevron are given in Table 3.

Table 3. Geometrical parameters of the chevron microactuator.

Description Variable Dimension

Beams length (µm) Lb 600
Beams width (µm) Wb 5
Angle of beams (◦) θ 1◦

Thickness structure (µm) t 70
Shuttle length (µm) Ls 660
Shuttle width (µm) Ws 30

The properly microgripper section of the complete device was initially designed considering two
structures based on simple compliance arrangements. Jaws tips were designed to favor grip, using a
toothed shape. The schematic diagram of the jaws’ section is shown in Figure 3, and its dimensions are
given in Table 4. Thickness of the microgripper is 70 µm. Later, this microgripper would be improved,
considering the determinant geometry elements on its displacement and reaction force.
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Table 4. Initial microgripper dimensions.

Element Value Element Value

gi 86.24 µm f 270.5 µm
a 340 µm αi 72.5◦

b 240 µm βi 72.5◦

c = d 227 µm χi 115◦

L1i 480 µm δi 124◦

L2i 50 µm

In accordance with [11], the here proposed microgripper can be considered as part of the class 1,
as it is based on lumped compliance mechanism. In this case, on a compliance rhombus frame.
In [11], inside class 1, there are also shown several cases of microgrippers actuated by chevron. In [27],
other example of microgripper actuated by chevron is provided, with thickness of 50 µm. Its application
as part of a micropositioner is also provided. The thickness of the device here chosen (70 µm) is near to
that value and is feasible to fabricate using SOI process.

Previous simulations of microgripper parameters, displacement, and force, lets us envisage the
elements to be parametrized, due to immediate influence on the microgripper performance:
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• The internal angles, represented by αi and βi, of the two symmetrical simple compliance
arrangements, which are the bases of the jaws.

• The length of the arms or jaws, L2, which initially have a length of 480 µm.
• The length of the beam, L1, which connects the simple compliance arrangement to the anchor.

Its length change has a significant impact on the displacement and force.
• The angles represented by χi and δi, also have a determinant influence on the microgripper

performance.

2.1. Chevron Model

In this section, the modeling of the displacement and force for the chevron actuator is given.
These variables are necessary as they support the jaw’s performance.

Displacement is calculated by [28]:

Uy=
Fy

N(S2 EA
L

+ C2 12EI
L3 )

(1)

where N is the number of beams, E is the Young’s modulus, L is the beam length, Fy is the actuation
force, A is the area of the cross-section, I is the inertia moment, S and C are sinθ and cosθ, respectively,
and θ is the aperture angle of each beam, as it is shown in Figure 1.

Inertia moment is calculated as follows [29]:

I =
wt3

12
(2)

where w is the beam’s width, and t is the device thickness.
The force is obtained by [30]:

Fy = NεAE sinθ (3)

where all variables where previously defined, except ε, the thermal deformation, which provides the
increment in the body’s dimensions, due to the increment in temperature, caused by the voltage supply:

ε = α∆T (4)

where α is the thermal expansion coefficient of the corresponding material, and ∆T denotes the
temperature change. Room temperature in this paper was considered as 22 ◦C.

Newton’s second law was used to calculate the maximum mass that the micro-gripper can support.
To obtain the displacement amplification factor (DAF), it is used [31,32]:

DAF =
d2

d1
, (5)

where d1 is the microactuator displacement and d2 corresponds to displacement between tips.
In the literature, there are reported amplification factors in the range from 2.85 up to 50,

for piezoelectric microgrippers, with applied voltages from 0 to 700 V, giving output forces from 1 µN
up to 1.87 N [31,33]. For electrothermal microgripper, with nickel, amplification factor of 7.89 was
reported, when two stacks of chevron actuators are used to drive two gripper arms [34].

For the electrical properties used in the microgripper design, the intensity of the electrical current
I can be calculated by using Ohm’s equation. The electrical resistance (R) can be determined from the
well-known equation:

R = ρ
l
A

(6)
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where ρ is resistivity, l is the length and A is the cross-section area, respectively. The total resistance of
each device is calculated in accordance with its configuration.

2.2. Resistive Modeling of the Chevron Microactuator of 8 Beams

Schematic model of chevron is given in Figure 4. Its volumetric resistive and electric models are
shown in Figure 5a,b, respectively.
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Resistances of each beam have the same value (RB1 = RB2 = . . . = RB8 = RB), simplified as:

RB = ρ
Lb

Wbt
(7)

where ρ is the resistivity, Lb, and Wb are length and width of beams, and t the thickness.
The general expression that describes the total resistance (RT) of chevron microactuator is given by:

RT = N
ρ

t

LaWb +
1
n (LbWa)

nWaWb

 (8)

where N is the numbers of beams, Wa and La, are the width and length of anchor, and n is the number
of the pairs of beams. It is important to mention that in the simulations, the effect on the anchor’s
resistance is also considered.

Other equation to calculate total resistance of a chevron with a pair of beams is given in [35]:

Re =
ρe × 2L

Ac
(9)
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where L = Lbx/(cosθ), Lbx is the horizontal beam component (adjusted notation), ρe is the electrical
resistance, Ac is the cross-sectional area (W × t), L, W, and t are length, width, and thickness of the
beam, respectively. θ is the pre-bend angle. Equations (8) and (9) are equivalents, if in Equation (8),
N = 2, n = 1, and La =Wa = 1. That means, without considering the anchor.

Calculation of stiffness constant can be obtained from [36]:

k =
2NE(12I cos2 θ+ AL2 sin2 θ)

L3 (10)

2.3. Microgripper

The microgripper shown in Figure 3 is normally open, and with the chevron actuation tends to be
closed. Figure 6 shows the geometry of one of its symmetrical arms. From its left side, it is observed
that a small cantilever is directly joined from its guided end to a compliant rhombus frame, which is
also direct joined to the extreme of the cantilever’s shuttle, which provides the displacement and force
to the compliant rhombus frame. This rhombus frame provides the force and displacement to jaws.
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The longitudinal force applied to the rhombus frame, from the shuttle, is given by:

Finx =
Fin sinϕ

2
(11)

where ϕ is equal to 59.8◦.
As it is known, rigidity depends on configuration, and the case of a rhombus frame is generically

flexible [37,38]. This advantage was used in this design. However, it is necessary to mention that
extreme cases of large deflection will not be generated, by this rhombus frame, because the magnitude
of the applied force, Fin, is lower than 3 mN, which is not enough to tapered drastically the rhombus
frame sides and change the apex angle (α) significatively, but the deflection of prismatic beams is
enough to generate the jaws displacement.

3. Results

3.1. Chevron Actuator Improvement

To improve the Silicon initial microgripper, a parameterization process was first applied to chevron
actuator and later, to gripper geometry. Chevron has been widely analyzed then, we only focus on its
parameterization, which will be performed considering a single pair of bent beams.

It is well-known, when a potential is applied across the anchors, it causes a temperature difference
due to joule heating. Variables will be called as follows: TM is the maximum temperature, T0,
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the temperature of one anchor, V, the voltage applied across anchors, Idc, the current flow through
it. The change in L, due to thermal expansion, is denoted by ∆L, and ∆y is the movement of the
shuttle [39]. In Figure 7, graphs obtained by parameterization of the determinant elements using
Ansys, as well as the analytical calculations for chevron actuator are given. These graphs provide the
trends of the actuator performance.
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Figure 7. Chevron actuator. (a) Beam length vs. displacement. (b) Pre-bend angles of beams vs. 
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Figure 7. Chevron actuator. (a) Beam length vs. displacement. (b) Pre-bend angles of beams vs.
displacement and force. (c) Beam width vs. displacement and force. (d) Structure thickness vs.
displacement and force. (e) Arrow width vs. displacement and force.

From Figure 7a, it is observed that with beams length of 600 µm, the shuttle displacement is
approximately 6 µm, which is found acceptable, considering the total length of the device, in addition,
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this length is feasible for its fabrication using SOI technology. The pre-bending angle is chosen as 1◦,
privileging displacement over force. If we consider an angle near the intersection point of graph shown
in Figure 7b, the total displacement of the microgripper is seriously decreased. From Figure 7c, it is
seen that the displacement is inversely proportional to beam width, while force is directly proportional.
Selection of a width beams of 5 µm was performed, again focused on displacement and maintaining
an acceptable width of the structure.

Trends of displacement and force with respect to structure thickness is shown in Figure 7d, as it
can be observed a linear increment of force against thickness, 70 µm is found convenient, and it
compensates the selection of pre-bending angle and beam width. In addition, adequate SOI prime
wafers are commercialized (Ultrasil Corp. Hayward, CA, USA), which can be used for the possible
fabrication. From Figure 7e, simulated results of displacement and force against shuttle width are
given, 30 µm are found suitable, as changes in force are not significant, and displacement changes are
also not determinant due to the chosen scales. After this parameterization analysis, it was decided to
maintain the initial values, given in Table 3, without changes.

3.2. Chevron Resistance

In Table 5, a comparison of the total resistance of chevron, is provided, with an error of 0.88%,
which is an indicator of the analysis precision.

Table 5. Comparison of resistance results.

Chevron Voltage (V) Current
Intensity (A)

Simulated
Resistance, (µΩ)

Analytical
Resistance, (µΩ)

Error
%

8 pair of beams 2 0.03085 64.93 65.5 0.88

3.3. Initial Microgripper

The initial proposal of microgripper, shown in Figure 3, was determined by means of try and failure,
without convection. ANSYS™ tool was used to improve the determinant elements of the microgripper
design by using parameterization through Finite Element Analysis (FEA), without convection.

Temperature distribution generated by applying a maximum voltage of 2 V at one anchors of
the chevron actuator, obtaining a maximum temperature of 112 ◦C, on the shuttle. One anchor is
considered at room temperature (22 ◦C). At this maximum temperature, ∆TM = 112 ◦C − 22 ◦C = 90 ◦C
is obtained.

The displacement obtained applying a maximum voltage of 2 V is 9.02µm in each jaw. The thickness
of the structure corresponds to 70 µm, and the reaction force obtained is 3795 µN. When the simulation
is performed considering a thickness of 15 µm, the reaction force is 795 µN. As can be seen, for a
thickness of 70 µm, the increase in force is considerable (477.36%).

3.4. Performance of Initial Microgripper

In the performance analysis of the initial and improved microgrippers, three conditions were
considered:

1. Anchors are fixed
2. Room temperature was applied to one of the anchors (300 ◦K)
3. Convective heat flux was also considered (20,000 W/m2 ◦K)

Under thermal convection, the heat is transferred by a moving fluid, and is usually the dominant
form of heat transfer in liquids and gases. Condition number 3, which was considered as a rule of
thumb, establishes that for dimensions less than 1 mm, there will likely not be any free convective
currents [40]. If the surrounding fluid is a liquid, the range of the forced heat transfer coefficients are
much wider. For free convection in a liquid h ≈ 50 to 1000 W/m2 ◦K is the typical range. Constant h is
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the film coefficient of heat transfer coefficient. For forced convection, the range is even wider h ≈ 50 to
20,000 W/m2 ◦K. In this case, air was considered as the fluid.

In Ansys, the procedure to perform convection analysis, is described as follows: in steady-state
thermal-electric conduction, convection is inserted, frontal device’s face is chosen, later h, the value of
fluid considered in forced convection, is added, and finally the ambient temperature is stablished.

Temperature distribution of initial microgripper against applied voltage is given in Figure 8,
under convection. From Figure 8, is possible to observe the variation of the maximum temperature,
with the applied voltage. A voltage sweep from 0 to 10 V was performed, which generates a maximum
temperature of approximately 497 ◦C, on the shuttle. The applied voltage parameterization was carried
out, in this case, to analyze its effect on the temperature on shuttle and jaws (Figure 8a,b), as well as on
the displacement generated in the jaws of the clamp and their reaction force (Figure 9). Due to this
response, it was selected to apply only 5 V. Temperature distribution in the microgripper, obtained with
this voltage, is shown in Figure 8c.
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distribution of initial microgripper @ 5 V.

In Figure 9, a voltage sweep from 0 to 10 V is also applied. A non-linear increase in displacement
is observed. The maximum displacement at 5 V, is 12.2 µm, considering both jaws, so the maximum
diameter of the clamping objects can be of 24.4 µm. Some examples of microtubes in this range
can be found at [41]. In the same Figure, the graph of voltage vs. force is displayed, with similar
tendency. About the relationship between thickness versus reaction force, from Figure 10, a quasilinear
dependence is observed. General data are given in Table 6.
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Table 6. Values of determinant elements and parameters of the silicon initial and improved
microgrippers @ 5 V, with convection.

Elements and Performance Parameters Initial Microgripper IMG1 (Focus on
Displacement)

IMG2 (Focus on Force
and Aperture)

α, [◦] 72 72 72
β, [◦] 107 107 107
χ, [◦] 115 110 110
δ, [◦] 129 150 150

L1, (µm) 50 50 50
L2, (µm) 480 350 400

Directional displacement *, (µm) X: 19, Y: 13.6,
Z: 7.6 × 10−3

X: 21, Y: 14.6,
Z: 2.6 × 10−3

X: 19.4, Y: 13.4,
Z: 7.8 × 10−3

Total displacement *, (µm) 24.4 26 23.32
Directional reaction

force, [mN]
X: 10.38 × 10−3, Y: 5.8,

Z: 0.11 × 10−3
X: 18 × 10−3, Y: 6.4,

Z: 1.9 × 10−3
X: 21.3 × 10−3, Y: 6.59,

Z: 3.05 × 10−3

Total reaction force [mN] 5.8 6.49 6.6
Initial opening (gi) (µm) 86.24 78 108

Final opening (µm) 61.84 52 84.64
Displacement amplification factor (DAF) 2.9 3.1 2.84

NOTE: *: It considers both jaws.
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3.5. Parameterization of the Initial Microgripper Elements without Convection

Graphs of parametrization results of angles α, β, χ, and δ, and lengths L1 and L2,
versus displacement and force, are given in Figure 11. They are useful to determine improved
geometries of the initial microgripper.
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About the angle’s selection, from Figure 11a,b that the initial value of the angles α and β, are very
close to the maximum values indicated in the corresponding graphs, so it was decided to conserve
them. In the case of χ, shown in Figure 11c, although the change in displacement is not so great, it is
slightly significant in the case of force, so it was considered to take a value of 110◦.
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For the δ angle, the behavior of displacement is like the previous case, but it is significant for the
case of force, which determines the new value of this angle (150◦). About the L1 length (Figure 11e),
it is observed that it is at the right point to obtain the greatest displacement, although the force is
slightly less than that the achieved at 100 µm. Then, its initial value was not changed.

For L2 (Figure 11f), the initial value is close to the maximum displacement, without greatly
sacrificing force (Improved Microgripper 1, IMG1). If the length value that allows maximum
displacement is selected, the initial opening of the gripper would be very closed, which depends on
the purpose for which it is intended.

If it is desired to maintain an opening like the initial one, the length of L1 value corresponding
to Improved Microgripper 2 (IMG2) can be chosen, where, in addition, provides an improvement in
strength, which may be desirable for another application. Dimensions of improved microgrippers
1 and 2, as well as their parameters are shown in Table 6.

3.6. Performance of Improved Microgripper 2, (IMG2)

Dimensions for IMG2 are given in Table 7. Its displacement response and reaction force when a
voltage sweep from 0 to 10 V is applied are given in Figure 12. Its temperature distribution at 5 V is
given in Figure 13. General data of the IMG2 performance are also given in Table 7.
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Table 7. Dimensions of the improved microgripper 2 (IMG2).

Element Value Element Value

g 108 µm f 270.5 µm
a 340 µm α 72 ◦

b 240 µm β 107◦

c = d 227 µm χ 110◦

L1 50 µm δ 150◦

L2 400 µm

From Table 6, it is observed that both improved grippers exceed the initial gripper force and
displacement parameters. The total displacement between the jaws is greater for IMG1, while the force
in IMG1 and IMG2 is greater than initial microgripper. The initial and final opening between the jaws
is greater in the case of IMG2.

In all cases, from directional displacement on Z axis, it is observed that the out-of-plane deflection
is minimal, providing a minimal cross axis sensitivity in this direction [42], which could represent a
great advantage, because this characteristic would avoid the realignment during the operation. For the
case of IMG2, the cross-axis sensitivity in this axis is 0.04%.

3.7. Comparison of Microgrippers

When IMG1 and IMG2 are implemented in polysilicon, their DAF, are 2.6 and 3.26, respectively,
applying 2 V. A comparison of IMG2 with other microgrippers were performed (top part of Table 8).
With Polysilicon, IMG2, comparing with the one shown in [20], allows to observe that at 50% of applied
voltage, IMG2 shown larger value of displacement (75%), but lower force (30%). Temperature on
chevron is similar, but in jaws, temperature is lower (15%). It is important to mention that [5] is actuated
by two chevrons, and implemented in metal, for this reason, it shows, in general, a better performance
at lower applied voltage. An additional advantage of the proposed gripper is its simplicity.

Table 8. Comparison with other electrothermal microgrippers.

Ref.

No. of Chevron
Actuators

(Beam length (L),
width (W), (µm))

Total Dimensions
(µm) Material

Total
Displacement

(µm)

Force,
mN

Temp. on Jaws
(◦C)

Applied
Voltage (V)

Without convection

[43] 2 chevrons
(L = 265, W = 10) 1015 × 520 × 10 Al 32.4 N/A 402 0.2

[5]
2 chevrons

(L = 150 and W = 5, L
= 50 and w = 4)

1100 × 400 × 10 Ni ~40 N/A ~698 on the
device 1

[20] 2 chevrons
(L= 400, W = 10) 870 × 10 PolySi 19.2 @ 1V 17 ~248.85 1.2

IMG2 One chevron
(L = 600 W = 5) 846.1 × 1314.1 × 70 PolySi 33.64 13 213.76 0.6

IMG1 and IMG2, with convection

IMG1 One chevron
(L = 600 W = 5) 846.1 × 1314.1 × 70 Si 26 6.49 35.29 5

IMG2 One chevron
(L = 600 W = 5) 846.1 × 1314.1 × 70 Si 23.32 6.6 37.26 5

IMG1 One chevron
(L = 600 W = 5) 846.1 × 1314.1 × 70 PolySi 33.38 13.6 23.86 2

IMG2 One chevron
(L = 600 W = 5) 846.1 × 1314.1 × 70 PolySi 40.66 17.8 25.21 2

The bottom part of Table 8 provides a comparison of IMG1 and IMG2, implemented in silicon
and polysilicon. With the last material, the grippers provide bigger values on displacement and force,
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than in the case of silicon, at lower voltage. With polysilicon, improved MG2 shows larger parameters
than improved MG1, simulated with the same material.

On the other hand, technical details about FEA analysis are provided in Table 9.

Table 9. Technical details about FEA.

Device
Solver
Target

Element Type/
Mesh

Face Sizing
with Element

Size

Inflation Convergence
Total
Mass
[kg]

Transition
Ratio

Max.
Layers

Growth
Rate

No. of
Total

Nodes

No. of
Total

Elements

Silicon initial
micro-gripper

Mechanical
APDL

SOLID
187/Refinement

Controlled
program (Tet10)

1.5e−6 0.272 5 1.2

984,826 133,633 0.482e−7

Silicon
IMG1 100,6675 136,535 0.4852e−7

Silicon
IMG2 35,771 16,428 0.474e−7

Polysilicon
IMG1 157,4935 321,710 0.462e−7

Polysilicon
IMG2 100,1318 135,999 0.455e−7

3.8. Frequency Response of IMG2, Implemented in Silicon

Modal analysis is performed to know the 3D microgripper mode shapes and its natural frequencies
(Table 10, Figure 14). This knowledge allows us to avoid the vibration of the microgripper at any of its
natural frequencies.

Table 10. Natural frequencies of modal forms.

Modal Form Natural Frequency (Hz) Modal Form Natural Frequency (Hz)

1 3.1633e4 4 6.8518e4
2 4.2130e4 5 7.0186e4
3 6.6395e4 6 1.2667e5
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From modal forms given in Figure 14 and Table 10, it is recommended that the microgripper
operates at frequencies lower to 31.633 Hz, corresponding to first modal frequency, which coincides with
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the expected performance of the microgripper. Regarding the analysis confidence, in [44], after analysis
of other two methods, the authors concluded that their results confirmed Finite Elements Analysis as
the most recommended method and used it to study complex structures.

3.9. Holding Microparticles with Silicon and Polysilicon IMG2

Figure 15 shows results of simulation, by FEA, of the IMG2 implemented with silicon, showing
it holding a microparticle. Simulation was also made with polysilicon. Results of both cases are
given in Table 11, which shows the generated stress and the reaction force into microparticles of
Au, glass ceramic, polycarbonate and carbon fiber (with Young’s modulus, in GPa, of 78.5, 91, 0.238,
and 230, respectively). In general, microparticles produces slightly lower values of stress, and total
reaction forces into microparticles for the case of silicon IMG2. The lowest values of stress and reaction
force correspond to the polycarbonate particle, and the largest values of both parameters correspond
to carbon fiber particles. From these results, all particles under holding could be manipulated without
damaging them.Actuators 2020, 9, × FOR PEER REVIEW 18 of 22 
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Simulation conditions for the manipulation of the microparticles shown in Figure 15,
performed with Ansys Workbench, are given in Table 12, providing a description of the complete
performed process.

Table 12. Simulation conditions for the manipulation of the microparticles, using Ansys Workbench.

Toolbox→ Static Structural→ Project→Model→ Assign materials to items→ connections

Connections Scope Definition Advanced

Contacts
Contact = 1 body->

microparticle selection
Target = 16 faces of gripper

Type = Rough
Behavior = Asymmetric

Pinball region = Radius
Pinball radius = 9e–5

Toolbox→ Static Structural→ Project→Model→ Assign materials to items→ connections→Mesh

Physical
preferences Sizing Quality Smoothing Nodes Elements Advanced

Mechanical Default Target quality =
Default (0.05) Medium 15534 7031 Pinball region = Radius

Pinball radius = 9e–5

Toolbox→ Static Structural→ Project→Model→ Assign materials to items→ connections→Mesh→ Static Structural

Fixed support Displacement Frictionless support Elastic support

Geometry = 10 faces only
pads

Component
X = free,

Y = 8.447 µm (in shuttle),
Z = free

Scope geometry = 1 face
cylindrical

Scope geometry = 3 faces,
Foundation stiffness =

Specific for each
microparticle material

4. Conclusions

An important feature of the proposed microgripper is its configuration based on the arrangement
of two simple compliant rhombus frame used at the base of each of the jaws. To improve its response,
parameterization process was performed for chevron actuator and the microgripper, in both cases,
without convection. With a thickness of 70 µm, the reaction force of the microgripper is compensated,
considering the other design elements selection, which was focused on displacement.

Parameterization processes are very useful to improve geometries. It provides graphical
information, which aid the user’s decision making. It is also necessary, to corroborate the complete
device performance in order to have a final decision.

To analyze the main performance parameters of the microgripper, convection was considered.
Based on the initial microgripper, two improved microgrippers were developed (IMG1 and IMG2),
simulated with silicon and polysilicon. In the last case, microgrippers have bigger values of displacement
and force, even though they are feed with lower voltage. The comparison of IMG2 with a more complex
microgripper found in literature, shows a larger value of displacement (50%), but a lower value of
force (30%).

From the jaw’s displacement and reaction force, the diameters allowed for the subjection objects
are found between 84.64 µm and 108 µm, using IMG2, with weights lower than 612.2 µg. Some tests of
microparticles holding were performed with IMG2, using as subjection objects to microcylinders of
Au, glass ceramic, polycarbonate and carbon fiber, showing the stress on them, as well as the total
reaction force induced, with permissible values in accordance to their mechanical properties, avoiding
generating a damage on them.

It is important to note that the temperature in the jaws of IMG2, implemented with Polysilicon,
applying 0.6 V to chevron actuator, is of 231.76 ◦C, but when convection and a feed of 2 V, are considered,
a temperature in jaws is reduced to 25.21 ◦C. In both cases, these temperatures are not extreme, and are
suitable for several kind of objects.

As future work, it is considered the fabrication of IMG2 using silicon or polysilicon. It is also
possible to improve the microgrippers performance using other materials or reinforce the design,
implementing additional structural elements.
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